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AKVIS CHARCOAL 7.0 | TURN PHOTOS INTO CHARCOAL & CHALK DRAWINGS

AKVIS Charcoal is an artistic tool that turns photos into charcoal and chalk drawings.

Convert your images into black and white dramatic drawings with a click! Create like famous artists!

Charcoal is one of the most popular materials for drawing. It lets you create a preliminary sketch as well as a complete work
of art. It combines the advantages of different materials and can be used together with different drawing tools. Using the
sharpened charcoal you can make thin clear lines. If you put it on the edge, you'll get a wide loose stroke. Charcoal creates
rich and easy picturesque strokes, both delicate and bold.

Chalk is one of the first creative tools for kids. It is ideal for sketching and creating large drawings on pavement or tinted
paper. White chalk is used to highlight bright areas of the image, add accents, and give the picture volume.

AKVIS Charcoal allows you to create drawings with each material, charcoal and chalk, or combine them using dramatic
contrast between black and white.

Playing with colors and options, you can get a lot of variants of the photo to drawing conversion and achieve outstanding
artistic effects such as Sanguine, Sepia, Sauce, and others.
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You can observe the conversion of your photo into a charcoal and chalk drawing in real time. The program makes snapshots
during processing and lets you choose between them. Thanks to the marvelous Timeline feature, it's possible to create
variations of drawings without adjusting the settings.
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Changing the color of the background paper gives even more variants of the final result. To make a drawing more authentic,
choose from a variety of canvas textures. Adding your signature to an image, you can feel like a real artist, the author of a
work of art. Apply a frame to your drawing from a rich Decoration's Library! Boost your creativity and use all the features of
the software to the fullest!
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The program offers a list of built-in Presets, ready-to-use settings combinations, which make it easier to work with the
software and save you time. You can create your own presets by saving your favorite combinations of the parameters.

Need to transform multiple images? The Batch Processing feature lets you automatically convert a series of files. Turn all
your photos into a charcoal sketchbook!
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AKVIS Charcoal is available as a standalone program and as a plugin for image editors: AliveColors, Adobe Photoshop,
Photoshop Elements, Corel PaintShop Pro, etc. Consult the compatibility page for more details.

The program's functionality depends on the license type (Home/Home Deluxe/Business). During the trial period you can try all
options and choose the license you like.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the desktop,
if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Charcoal, in AliveColors: Effects -> AKVIS –> Charcoal.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-charcoal-app.dmg to install the Standalone version

- akvis-charcoal-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Charcoal application or AKVIS Charcoal PlugIn inside.

4. To install the Standalone version, drag the AKVIS Charcoal app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Charcoal PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;
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Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.

 

AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Charcoal, in AliveColors: Effects -> AKVIS -> Charcoal.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using the
uname -srm command.

 

Follow the instructions to install the AKVIS software on a Linux computer.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys:

sudo mkdir -p /usr/share/keyrings 

3. Download the key that signed the repository:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Add the repository to the list where the system looks for packages to install:

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com
akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Update the list of known packages:

sudo apt-get update 

6. Install AKVIS Charcoal

sudo apt-get install akvis-charcoal 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command:

sudo apt-get upgrade 

To remove the program:

sudo apt-get remove akvis-charcoal --autoremove 

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository:

sudo rpm --import https://akvis.com/akvis.asc 

3. Add the repository to the system:

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Update the package list:

when using the dnf package manager:

sudo dnf update 

when using the yum package manager:

sudo yum update 

5. Install AKVIS Charcoal:
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when using the dnf package manager:

sudo dnf install akvis-charcoal 

when using the yum package manager:

sudo yum install akvis-charcoal 

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager:

sudo dnf upgrade 

when using the yum package manager:

sudo yum upgrade 

8. To remove the program:

when using the dnf package manager:

sudo dnf remove akvis-charcoal 

when using the yum package manager:

sudo yum remove akvis-charcoal 

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository:

rpm --import http://akvis.com/akvis.asc 

4. Add the repository to the system:

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Update the package list:

zypper ref 

6. Install AKVIS Charcoal:

zypper install akvis-charcoal 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates:

zypper update 

To remove the program:

zypper remove akvis-charcoal 

 

Installation using Flatpak:

1. Run the terminal.
2. Add the Flathub repository

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

3. Add the AKVIS repository
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sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Install AKVIS Charcoal:

sudo flatpak install -y akvis com.akvis.akvis-charcoal 

5. The installation is completed.

Launch the program using the program shortcut or the terminal:

flatpak run com.akvis.akvis-charcoal 

6. To update all installed flatpaks, use the command:

sudo flatpak update -y 

to remove the program:

sudo flatpak remove -y com.akvis.akvis-charcoal 

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Charcoal and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Charcoal.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change Home
to Home Deluxe or Business).
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WORKSPACE

AKVIS Charcoal converts a digital photo into a drawing made with charcoal and chalk. This artistic software can be used
independently as a standalone program or in a photo editor as a plugin filter.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

The workspace will be arranged according to the editing mode chosen in the Control Panel: Express, Advanced or Presets.

In Express mode, the program's interface is extremely simplified. It has the minimal set of parameters needed for a user to
quickly obtain a satisfactory result.

Workspace of AKVIS Charcoal (Express)

In Advanced mode, the full functionality of the program is available: all parameters, under the relevant tabs Drawing,
Decoration, as well as the toolbar.

Note: All features and parameters work in Express mode. Some are hidden and use default values or those of a chosen
preset.
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Workspace of AKVIS Charcoal (Advanced)

Click Presets in the top panel to switch to the presets visual display mode. The presets can be shown in the right panel or on
the entire window (Presets Gallery).

AKVIS Charcoal Workspace (Presets Mode)

 

The left part of the AKVIS Charcoal window is taken by the Image Window with two tabs: Before and After. The Before
tab shows the original photo, the After tab - the result. You can switch between them by left-clicking on the tab with mouse
button. To compare the original and the resulting images, click on the image and hold the button pressed - the program will
currently switch between tabs.

 

In the upper part of the program's window you can see the Control Panel.
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The button  opens the home page of AKVIS Charcoal.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac.

Right mouse click on this button displays the list of recent images. You can change their number in the program’s
Preferences.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P  on Windows,

⌘ +P  on Mac.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.

The button  imports a list of presets (from the .charcoal file).

The button  exports presets (user settings for the image processing). You can save any number of presets to a

separate file with the ending .charcoal.

The button /  shows/hides the guiding lines.

The button  loads saved guiding lines (from the .direction file).

The button  saves the guiding lines to a file with the .direction extension.

The button  cancels the last operation (with the tools). It is possible to cancel several operations in a row. The

hotkeys are Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys

are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  initiates image processing with the current settings. The resulting image is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  shows information about the program: version, trial period, license.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program’s options.

The button  opens a window showing the latest news about Charcoal.

 

To the left of the main window there is the Toolbar. Different tools appear depending on the active tab, Before or After. The
tools are divided into the groups: pre-processing (in the Before tab), post-processing (in the After tab), and additional tools
(available in both tabs).

 

You can navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image
which is visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby
changing the visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left
mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed – to the
left/to the right, by keeping the Alt  key pressed − scale the image. Right-click on the scroll bar to activate the quick
navigation menu.

Use the slider to scale the image. When you move the slider to the right, the image scale increases. When you move the slider
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to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some
frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator there is the Settings Panel with the Drawing and Decoration tabs:

Drawing: Adjust the settings of the charcoal and chalk effect.

Decoration: Add text to your image, adjust the canvas, and apply a frame.

 

Below, in the Presets field you can save the current settings as a preset to use them in the future. The current settings can
be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the program's Preferences.
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HOW TO USE THE PROGRAM

AKVIS Charcoal lets you transform a photograph into a charcoal and chalk drawing. The software can be used independently
as a standalone program or as a plugin filter in a photo editor.

The functionality of the software depends on the license type. Consult the comparison table. During the trial period you can
try all options and choose the license you like.

To create a drawing from your photo, follow these instructions:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you

click on the button  on the Control Panel. Use the hot-keys: Ctrl+O  on Windows, ⌘ +O  on Mac. You can

also drag the required image into the workspace of the program.
The standalone program supports JPEG, RAW, PNG, BMP, WEBP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open.

Call the plugin from the menu of the editor:

in AliveColors: Effects -> AKVIS -> Charcoal; 
in Adobe Photoshop and Photoshop Elements: Filter -> AKVIS -> Charcoal; 
in Corel Paint Shop Pro: Effects –> Plugins -> AKVIS –> Charcoal; 
in Corel Photo-Paint: Effects -> AKVIS -> Charcoal.

Step 2. The workspace will be arranged according to the interface mode chosen in the Control Panel: Express,
Advanced, or Presets.

AKVIS Charcoal Workspace

Step 3. In the standalone version, before applying the effect, you can cut off unwanted areas of the picture and

improve its composition with the Crop tool . If you use the plugin, you can do this in your image editor.
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Crop Tool

Step 4. Adjust the effect settings in the Drawing tab. You can choose one of the presets or set the parameters to
your liking.

The result will be immediately shown in the quick preview window which is visible in the Before tab if the button  in

the Toolbar is pressed.

Preview Window

Step 5. To convert the entire image into a charcoal and chalk drawing press the button .

The progress bar appears over the image, with the icon  (to make a snapshot) and the Stop button (to interrupt

the process).

Step 6. You can improve the result of the automatic photo-to-drawing conversion with the Stroke Direction tool .

Note: This feature is only available for the advanced licenses (Home Deluxe and Business).
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Draw guiding lines with the tool and click on  to re-process the image.

Step 7. To make your drawing even more realistic and increase the visual appeal of the image, you can use the
Decoration options: Canvas, Frame, and Text.

Hint: The order of the application of the decoration effects depends on the position of the tabs. Drag the tabs to
change the order.

Charcoal and Chalk Drawing + Canvas + Text

Step 8. If you like your new settings, you can save them as a preset and use them later. Type a name for the preset
into the Presets field and press Save.

Click on a heart icon /  near the preset name field to add the preset to Favorites or to remove it from this group

of presets.

Learn more about the Charcoal Presets.

Step 9. During the image processing, the program creates a list of intermediate shots which represent different stages
of conversion - from a semi-processed sketch to a practically finished work. They are displayed in the Timeline at the
bottom of the main window. You can choose any of the intermediate results by clicking on it. The last image is the final
result.

Note: This feature is only available for the Home Deluxe and Business licenses.

Timeline Shots

You can also add your favorite moments of image processing to the Timeline by taking a snapshot with the button 

that is located right of the progress bar. Read more.

Step 10. You can edit the result and put the finishing touches to your drawing with the post-processing tools:

Charcoal , Chalk , Eraser , and History Brush .

Note: These tools are only available for the Home Deluxe and Business licenses.
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Hint: Use the post-processing tools at the final step! If you run the processing  again, the changes made

with the tools will be lost.

Step 11. In the standalone version, you can also print your result using .

Charcoal and Chalk Drawing

Step 12. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save As dialog box. You can use the hot-keys: Ctrl+S  on Windows, ⌘ +S

on Mac. Enter a name for the file, choose the format (TIFF, BMP, JPEG, WEBP, or PNG) and indicate the target
folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Charcoal plugin will close and

the picture will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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CHARCOAL & CHALK DRAWING

AKVIS Charcoal transforms your photos into charcoal and chalk drawings. Sketching with charcoal is an easy and fun
technique. Using charcoal and chalk is an expressive drawing style.

Charcoal is one of the most popular materials for drawing. It lets you create a preliminary sketch as well as a complete work
of art. It combines the advantages of different materials. Depending on how you hold the charcoal, you will get sharp clear
lines or wide loose strokes.

Chalk is similar in texture and appearance to pastel. In its traditional white color, chalk is used to highlight bright areas in an
image, add accents, and give your picture volume.

Using both tools you can create professional-looking expressive black and white images. It's also possible to play with colors
to achieve outstanding artistic effects, such as sanguine, sepia, or others.

Charcoal and Chalk Drawing from Photo

AKVIS Charcoal
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Blend with Original = 0

 

Blend with Original = 50

 

Normal

 

Linear Burn

 

Light Paper

 

Dark Paper

Adjust the effect settings in the Drawing tab:

Blend with Original (0-100). The effect can be merged with the original image by changing the transparency of the
result. With a value of 0, no blending occurs. The higher the parameter, the more the original colors are mixed with the
result.

In the Mode drop-down list, you can set the blending method.

Paper Color. Change the color of the background. Click on the color plate to choose the color from the image with the
eyedropper. Double click to open a standard color selection dialog.

Enable the Charcoal and Chalk check-boxes to choose drawing materials - both or one of them.
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Charcoal and Chalk Drawing

 

Charcoal Drawing

 

Chalk Drawing

 

Stroke Thickness = 20

 

Stroke Thickness = 70

 

Min Length/Max Length = 5/20

 

Min Length/Max Length = 50/150

You can select colors for the charcoal and chalk strokes with the color plates.

Note that these colors will also be used for the post-processing tools: Charcoal  and Chalk .

Strokes Tab:

Stroke Thickness (10-100). The parameter defines the maximum width of the strokes. The width can vary, but will not
exceed the specified value.

Min Length/Max Length (5-500). The parameter sets the full range of the possible stroke lengths. In the drawing,
only those strokes will be displayed which are greater than the minimum length (the left slider) and shorter than the
maximum length (the right slider).

Density (1-100). The parameter affects the amount of pigments in a stroke. The higher the value, the brighter and
denser the stroke will be.
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Density = 10

 

Density = 60

 

Smudging = 10

 

Smudging = 100

 

Pressure = 5

 

Pressure = 50

Smudging (0-100). The parameter adjusts the degree of blurring and smearing, making the drawing softer.

Pressure (1-100). The parameter defines the degree of the strokes visibility. Low values produce the lighter strokes.
Increasing the value makes the strokes brighter and more pronounced.

Intensity (0-100). The parameter adjusts the brightness and expressiveness of the strokes. Increasing the value
increases the shading.
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Intensity = 25

 

Intensity = 75

 

Shadows = 5

 

Shadows = 50

 

Precision = 3

 

Precision = 30

 

Hatching Tab:

Shadows (0-100). At low values, the image is flatter. Increasing the value makes the drawing more voluminous, three-
dimensional, the shadows become deeper and richer.

Precision (1-100). The parameter defines the precision and accuracy of the strokes. At low values, the image is blurry.
The higher the value, the more clear lines and details appear.

Smoothing (0-100). Increasing the value makes the transitions between the strokes smoother.
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Smoothing = 0

 

Smoothing = 100

 

Alignment = 20

 

Alignment = 90

 

Sensitivity = 40

 

Sensitivity = 90

Alignment (10-100). The parameter adjusts the position of the strokes. At low values, the strokes are applied
randomly, chaotically and twisted. At higher values, they are drawn more neatly and evenly.

Sensitivity (1-100). The parameter is responsible for finding the edges. The higher the value, the more contours and
details appear in the image. Decrease the value to remove odd lines.

Charcoal Density (1-100). The parameter changes the number of the charcoal strokes.
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Charcoal Density = 10

 

Charcoal Density = 50

 

Charcoal Hatching = 25

 

Charcoal Hatching = 75

 

Chalk Density = 1

 

Chalk Density = 30

Charcoal Hatching (10-100). The parameter defines the areas shaded with charcoal. At low values, the charcoal
appears only in the darkest areas. Increasing the value adds charcoal strokes in lighter areas.

Chalk Density (1-100). The parameter changes the number of the chalk strokes.

Chalk Hatching (10-100). The parameter defines the areas shaded with chalk. At low values, the chalk appears only in
the lightest areas. Increasing the value adds chalk strokes in darker areas.
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Chalk Hatching = 20

 

Chalk Hatching = 70
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TIMELINE

In AKVIS Charcoal you can observe the conversion of your photo into a charcoal and chalk drawing in real time. During the
process, the program creates a list of intermediate shots which represent different stages of conversion — from a semi-
processed sketch to a practically finished work. Without changing the settings you can create variations of drawings and
choose any of them.

The Timeline is displayed at the bottom of the main window.

AKVIS Charcoal

Attention: The Timeline feature can only be used by owners of Home Deluxe and Business licenses. Note that everyone,
even with a Home license, can get a semi-processed image using the Stop button in the progress bar.

 

Start conversion of your photo into a drawing by pressing the button . You will see shots appearing at the bottom of the

window in the course of processing.

You can also take snapshots of your favorite moments with the button  right of the progress bar. When you press it the

drawing in its current state will be added to the list; such manual shots are selected with the blue frame.
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Image Processing

If you press the Stop button in the progress bar, image processing will be interrupted.

Browse the shots in the Timeline to find the image you like most. If you want to get back to your final result, click on the
last shot in the list.

Variants of Drawing

When you re-run image processing with new parameters, the Timeline will be cleaned up and will start being filled up with
new shots. You can save the variants you like by pinning them with a double click. In the upper corner of such shots appears

the icon .

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It’s
possible to unpin it with a double click.

To delete a snapshot, select it in the Timeline and click on .

Attention! Pinned shots can't be removed with this button! 
Loading a new image into the program removes all shots, including pinned ones.
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Note:

After using the post-processing tools , , , , switching to another image in Timeline will result in the loss of

changes made with the tools. You can save the result under a new name and continue working.

 

You can hide/show the Timeline in the program's preferences . If the Timeline Shots option is enabled, you can set the

number of the shots created during image processing.

Program's Preferences
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Toolbar, Before tab

 
Toolbar, After tab

TOOLS AND THEIR OPTIONS

In AKVIS Charcoal, different tools become visible depending on the active tab, Before or After.

 

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and
additional tools (Before and After tabs).

Hint: Use the buttons  and  to undo/redo the operations made with the tools: , , , , .

 

Pre-Processing Tools (on the Before tab):

Quick Preview  switches on/off the preview window. It is a square frame outlined with the "marching ants" that

displays changes made in the Drawing and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you
quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the
original picture, click and keep mouse pressed within the preview area.

Preview Window

You can adjust the preview window size in the program’s preferences .

 

Crop  (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to

improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

You can change the crop area by dragging the sides and the angles of the bounding frame.
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Automatic Strokes

 

Guiding Lines Changed Direction

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit

the tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.

Crop Image

Adjust the crop options:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

 

Stroke Direction  gives you full control over the strokes. With this technique you can achieve truly realistic

drawings with patterns and textures going in the right direction.

Note: This feature is only available for the advanced licenses (Home Deluxe, Business).

Add the guiding lines with this tool, and the program will re-make the drawing following the new direction. The changes

will be shown in the preview window. To re-start the image processing, click on the button .

 

Hint: You can save  and load  the guiding lines created with this tool. 
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Charcoal & Chalk Effect Using Tools

Loaded lines automatically adapt to the image size.

 

Eraser  lets you edit and remove the guiding lines drawn with the Stroke Direction tool . The size of the eraser

can be adjusted by right clicking on the image.

 

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The post-processing tools , , ,  are only available under the Home Deluxe/Business licenses,

on the After tab. Use them at the final step. If you re-run the image processing , the changes made with the

post-processing tools will be lost!

The tools’ options are shown in a pop-up box which appears after right-clicking in the image.

Using the Charcoal  and Chalk  tools you can strengthen the hand-made effect and draw soft textured strokes

with colors selected in the effect settings.

Size (5-200). The maximum line width which can be drawn with the tool.

Strength (1-100). The impact of the tool.

Show Original (0-80). When increasing the parameter, the original image becomes visible through the effect. This
parameter is auxiliary, it is useful for more precise drawing with the tools and does not affect the result.

 

Eraser  lets you erase the charcoal and chalk lines, both generated with the program and drawn with the tools.

Size (1-1000). The maximum width of the transparent line which the eraser leaves behind (in pixels).

Hardness (0-100). The amount of blurriness of the brush's edge. As the value of this parameter increases the
edge of the brush becomes harder. Near 100% the border between erased and unerased areas will be more
distinct; at lower values the boundary between these areas will be smoother.

Strength (1-100). The amount of influence on an image. As this parameter's value is increased, the degree of
transparency left by the brush increases.

Show Original (0-80). When increasing the parameter, the original image becomes visible through the effect. This
parameter is auxiliary, it is useful for more precise drawing with the tools and does not affect the result.
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Charcoal & Chalk Effect

 

Using Eraser

 

History Brush  lets you fade the charcoal and chalk effect and restore the image to its original state or to the

processing result. You can choose the mode of the tool: edit all changes or only the tools keeping the effect.

The tool's parameters:

Size (1-1000). The maximum width of a line made by the brush.

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges
become. At value 100% the border between the brush's edges and the background is very distinct; at lower
values the transition between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration
and more blending with the effect; at value 100% the image will be restored more completely.

Restore to Original. If the check-box is enabled, the tool lets weakening the drawing effect, as well as the result
of the post-processing tools. If the check-box is disabled, the brush edits only the tools but does not affect the
result of the image processing.
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Before Using The Tool

 

Using History Brush

 

Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the

button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction.
The hot-key is H .

Double-clicking on the tool’s icon   on the Toolbar makes the image fit the window.

Zoom  lets you change the image's scale. To zoom in left click on the image. To zoom out left click with Alt  on the

image. The hot-key is Z .

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).
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CHARCOAL & CHALK DRAWING ON CANVAS

Using AKVIS Charcoal you can put your drawing to any surface: sanded paper, brick wall, and others.

In the Decoration group switch to the Canvas tab and enable the Use Canvas check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

 
Using Canvas

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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ADDING A FRAME TO YOUR DRAWING

In AKVIS Charcoal you can also add a frame to your charcoal and chalk drawing.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Frame

 

You can apply these frames to decorate your drawing:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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ADDING TEXT OR WATERMARK TO YOUR DRAWING

In AKVIS Charcoal you can personalize your charcoal and chalk drawing by adding a signature, a logo, or a watermark.

In the Decoration group switch to the Text tab and enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Text

You can add any text or image.

Adjust the text/watermak settings.
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CHARCOAL & CHALK EFFECTS PRESETS

AKVIS Charcoal imitates the technique of drawing with charcoal and chalk. The program includes a number of ready to use
Presets which help you start working. When moving a cursor over an AKVIS preset in the drop-down list, the quick result
appears in the small window near the list. The presets can be applied "as is" or can be modified.

A preset contains the settings of all tabs. To process the image with a certain preset, select it from the list and press .

You can apply one of the AKVIS presets or modify the parameters to achieve the desired result.

To create your own preset, adjust the settings, type a name for the preset, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete a preset, choose it from the drop-down list and press Delete. The AKVIS built-in presets cannot be removed.

 

Add a preset to Favorites by clicking on  next to the list of presets. The selected preset will be marked with a red heart 

.

 

Presets Gallery

Click the Presets button in the top panel to switch to the visual display mode of presets with the real-time approximate
preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an image is
loaded into the program, preset thumbnails are generated.

Click a thumbnail to select the preset. Double-click the thumbnail to process the entire image.

Double-click the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list; 

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);

 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.

You can save your presets to a .charcoal file with . To load presets from the file use .

Read more how to import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box that looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;
- 100%. The actual size is used, the image doesn't scale.

Preview Window Size. Choose the desired value for the size of the quick preview window: from 400х400 px to
1000х1000 px.
Processing Size Limit. Image processing is a very time-consuming operation. This parameter accelerates image
processing by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not
exceed the defined value, the image is processed in the usual way. If the loaded file is larger, the program will reduce
the image, process it and enlarge it again to the initial size.
Timeline Shots. This option lets you hide/show the Timeline. If the check box is enabled, you can set the number of
the shots created during image processing.
Hints Panel. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files,

sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Use OS File Dialog. Enable this option if you want to use the System Open/Save Dialog. Otherwise, the AKVIS File
Dialog is used.
Lock the Control Panel. It disables the possibility to hide/show the top panel. If the check box is selected the panel is
always visible.

To apply changes made in the Preferences window press OK.

If you need, click on the button Default to return to the default settings.
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BATCH PROCESSING

AKVIS Charcoal supports the Batch Processing feature that lets you automatically convert in drawings a series of images
with the same settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style
for a booklet or when processing all frames of video.

 

Even if you’ve never used this feature before it is simple to learn!

If you use the standalone version of AKVIS Charcoal, read the instructions here.

If you use the Charcoal plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method
applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in
Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-files"
folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and
create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new set of
actions, for example, "AKVIS".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Oil".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In the Actions

palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File
menu and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS" and the new action.
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In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands check-box
should be deactivated.
For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to
change the names, in the first combo-box choose document name, and in the second - extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder,
one by one, and will save them to the "result-files" folder.
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PRINT IMAGES IN AKVIS CHARCOAL

In the standalone version of AKVIS Charcoal you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Charcoal

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

AKVIS Charcoal

56



Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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CHARCOAL SKETCH

Charcoal is expressive and simple material that lets you draw a sketch with a few strokes.

Using AKVIS Charcoal you can quickly create a charcoal sketch from your photo.

Read how to transform a photo into a charcoal contour line drawing:

Step 1. In AKVIS Charcoal, choose one of the ready-to-use presets or adjust the effect settings. All changes are
immediately displayed in the preview window.

Step 2. Press the button  to launch full image processing. You will see intermediate shots appearing in the

Timeline.

After processing is complete, you can select your favorite variant of drawing by clicking on it in the Timeline (this
feature is only available for Home Deluxe and Business licenses).
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Image processing can also be interrupted at any time by pressing the Stop button next to the progress bar (available
for all types of licenses).

The result will be shown in the After tab.

Step 3. You can edit the result: remove extra lines and add new strokes using the post-processing tools (available for
Home Deluxe and Business licenses).

The most useful tool is Eraser  that lets you easily remove unwanted strokes.

Step 4. You can also add the canvas texture to your sketch.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a Business
license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Turn Photos into Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects such as sanguine, sepia, and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage AI allows colorizing B&W photos. The program includes an AI-powered image colorization mode based on
machine learning, as well as the classic method of manual coloring using zone selection. Breathe new life into your old family
photographs! More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail,
Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a
picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program
can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect for Your Photos

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask AI — Selection Made Easy

AKVIS SmartMask AI is an efficient selection tool that saves time and is fun to use. Equipped with artificial intelligence tools,
the program is the most convenient and fastest way to mask objects in an image. The software considerably increases your
productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…

AKVIS Charcoal

70

https://akvis.com/en/retoucher/index.php?utm_source=help
https://akvis.com/en/retoucher/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/smartmask/index.php?utm_source=help
https://akvis.com/en/smartmask/index.php?utm_source=help
https://akvis.com/en/smartmask/index.php?utm_source=help
https://akvis.com/en/watercolor/index.php?utm_source=help
https://akvis.com/en/watercolor/index.php?utm_source=help


AKVIS Charcoal

71

https://akvis.com/en/watercolor/index.php?utm_source=help

